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Working with the
Visual Basic Editor

Objectives

• Open the Visual Basic Editor.

• Introduce the Project Explorer, the Properties Window, and the
Immediate Window.

• Work with VBA projects.

• Define components of a code module.
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Overview of the Visual Basic Editor

As you saw in the previous section, you create and run VBA code in the Visual
Basic Editor. The Visual Basic Editor, or VBE, is a full-featured development
environment that contains tools to help you create and manage VBA projects.
This section introduces the VBE and some of the tools it contains.

The Visual Basic Editor found in Word, Microsoft Excel, and other VBA hosts
looks and behaves similarly to the Integrated Development Environment found
in Visual Basic 5.0. In fact, the VBE is based on the Visual Basic development
environment, although it doesn’t have all of the features found in Visual Basic.

Opening the Visual Basic Editor

You can open the Visual Basic Editor from the host application you’re
working in. All of these methods work from Microsoft Excel, Word,
PowerPoint, and Visio. With some host applications, however, you may have
to use a slightly different approach.

1. Open a document in the host application. For example, create a new
spreadsheet in Microsoft Excel or a new document in Word.

2. Use one of the following methods to open the VBE:

• From the Tools menu, select Macro, then Visual Basic Editor.

• Right-click the Standard Toolbar to show the list of available
toolbars. Select Visual Basic to show the Visual Basic toolbar, then
click the Visual Basic Editor button.

• Press ALT-F11.

The Visual Basic Editor appears as shown in Figure 1. You can switch back
and forth between the host application and the VBE by using the Windows
Taskbar or pressing ALT-TAB.
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Figure 1: The Visual Basic Editor in Microsoft Excel.

The Project Explorer

The Project Explorer window displays a list of open VBA projects and each
project’s components. The Project Explorer organizes the components of a
project into a neat hierarchy. You can use the Project Explorer to navigate and
manage your projects and the components they contain.

If the Project Explorer isn’t visible in the VBE, select ViewProject
Explorer, or press CTRL-R.

 The Project Explorer contains its own toolbar, which you can use to open
components in the project as shown in Figure 2. Click the View Code button
to view the code module associated with an object; click the View Object
button to view the object itself, such as a form.
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Figure 2. The toolbar in the Project Explorer.

The Properties Window

The Properties window displays properties for an object that you can set while
you’re designing your application. A property is the characteristic that you can
set for an object, such as its name, color, or size.

If the Properties window isn’t visible in the VBE, select ViewProperties, or
press F4.

The Immediate Window

You can run VBA code from an event even as you are developing the
application in the VBE. If you want to test some bit of code quickly, however,
you can do so in the Immediate, or Debug, window. This special window,
shown in Figure 3, allows you to try out expressions, execute code, change
values, and, of course, debug your applications. We’ll use the Immediate
window throughout this section and the entire course.

Figure 3. Use the Immediate window to calculate expressions, run code, and
debug your applications.
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TIP: You can use the Immediate window anytime within the VBE by pressing

CTRL+G. It’s one of your best tools for determining why your application

isn’t working correctly. Taking the time to learn the Immediate window can

save you hours of work.

The Code Window

Almost all objects in a project include a container, or code module, where
VBA code is entered. The Code window displays the code module and
provides rich editing functionality and ease of navigation as you write code.

To view an object’s code module, right-click the object in the Project
Explorer and choose View Code.
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Working with Projects

What is a VBA Project?

When you create a new Word document, Microsoft Excel spreadsheet,
PowerPoint presentation, or Microsoft Access database, you automatically
create a VBA project that’s associated with that document, presentation,
spreadsheet, or database. The VBA project stores all of the written code and
any additional components.

To work with a document’s individual VBA project simply open the Visual
Basic Editor and select the appropriate project in the Project Explorer.

What Types of Components Does a
Project Contain?

A project can contain the following types of components:

• Objects that are part of the application.

In Figure 4, Project Explorer is displaying a Microsoft Excel project. The
first folder in the folder list is titled Microsoft Excel Objects, and the
objects in this folder are named Sheet1, Sheet2, Sheet3, and
ThisWorkbook. These objects represent the Microsoft Excel workbooks
and worksheets that you see in the user interface.

To see that these objects belong to the user interface, select an object, such
as Sheet1, and from the Project Explorer toolbar click View Object.
You’ll see the object displayed in the user interface.

The objects displayed in this part of the Project Explorer depend on which
application you’re working in. We’ll discuss these objects in more detail
later in the course.
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Figure 4. The Project Explorer as it appears in Microsoft Excel.

• Forms

Take a look at Figure 4 again. Beneath the Microsoft Excel Objects folder
is a folder labeled Forms containing an object named UserForm1. You use
forms to create custom dialog boxes, like the ones you saw in the first
section.

Any custom forms that you create are stored with the VBA project and
they appear in the Forms folder. The Forms folder only appears after forms
have been created.

• Modules

Again inFigure 4, the Modules folder appears beneath the Forms folder. It
contains standard modules that you can use to write generic procedures.
The Modules folder only appears after modules have been created.

• Class Modules

Class modules are special modules you use to create your own objects.
You don’t need to worry about them at this stage; we just wanted to show
you all the components you might see in the Project Explorer.

NOTE Some applications may display different components in the Project
Explorer.
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Adding Items to a Project

From within the Project Explorer, you can insert new forms, standard modules,
and class modules. Click the Insert menu and select the type of component you
want to add as shown inFigure 5.

Figure 5. Use the Insert menu to add a new form or module.

The Project Explorer will not let you add new host-specific objects. For
example, you can’t add new Microsoft Excel Objects from the Project
Explorer. You must add them from the Microsoft Excel user interface.

To remove an item from a project, select the item in the Project Explorer,
right-click, and choose Remove itemname, where itemname is the name of the
item to remove.

Working with Multiple Projects

When you open more than one document in Microsoft Excel, Word or
PowerPoint, a project appears in the Project Explorer for each open document.
You can work with any of the open projects but make sure you’re working
with the correct object. If you’re not currently working with a project, you can
double-click the project in the Project Explorer to hide its components.

NOTE Some VBA hosts may not allow you to work with multiple
projects.

TIP: When you’re working with several projects at a time unique names help to

distinguish one project from the next.  Select Tools | Project Properties to

change project names.
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Viewing a Code Module

Most of the components in a project have code modules where you enter code.
There are three types of code modules: standard, form, and class. Each is used
for a different purpose, which we’ll discuss in more detail as we go on.

To open a code module, perform the following steps:

1. From Project Explorer select the item whose code you want to view. It
can be an application-specific object, a form, a standard module, or a class
module.

2. Right-click the object and choose View Code.

If the View Code command is grayed out, then the object you’ve selected
doesn’t have a code module.

Anatomy of a Module

Let’s take a look at the different parts of a code module, which are labeled in
Figure 6.

Figure 6. The different parts of a code module.

The Declarations Section

You can think of a module, metaphorically, as a roll of paper towels in that
almost every sheet is similar, except the very first sheet. On a roll of paper
towels, the first sheet has glue on it that keeps it stuck to the rest of the roll. In
a module, the first sheet is called the Declarations section, and its where you
place instructions, declarations, and other elements that your module needs.
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TIP: Everything you place in the Declarations section applies at least to the entire

module. You can make items you place there apply to more than just the

module itself, but that’s a topic for another day.

The Object and Procedure Lists

The Code window includes two drop-down lists. The Objects list, shown on
the left, displays all objects associated with the module. ”General” is a default
object in the list that refers to any procedures not associated with a particular
object. The one on the right, the Procedure list, displays all the procedures in
the module, including event procedures associated with objects.

Use these lists to navigate through a module that has more than just a few
procedures in it. Select the procedure you’re looking for in the Procedure list,
and VBA will move the cursor there. If it’s an event procedure, select the
name of the object from the Object list first, then find the specific event
procedure in the Procedure list.
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Creating a Simple Procedure

As we’ve stated, a procedure is a discrete unit of code that performs a specific
task. All of the VBA code you write will be contained in procedures.

There are two types of procedures you need to be concerned about as you’re
learning VBA: Function procedures and Sub procedures (also known as
subroutines). A Function is a procedure that performs an operation and returns
a value. A Sub procedure also performs an operation, but it doesn’t return a
value.

More often than not procedures are created as Functions. Think of it this
way—even if you’re only executing an action, you’ll often want to return a
success code back to the code that called the procedure. It is important for your
code to know if the procedure was successful or not so it can proceed with the
remainder of the action.

You’ll still work frequently with Sub procedures, however. Sub procedures are
used when your direct response is needed to a particular event. You can also
use a Sub procedure when you’re executing an operation that is not too
complicated and is unlikely to fail.

Your First VBA Function

The scenario: As part of an application you’re writing, you need to take three
pieces of an address (City, State, and Zip), and format them correctly for bulk
mailing. The Post Office wants these displayed in upper case, with one space
between each portion, and with no punctuation. You could, every time you
need to print an address, do the tiny bit of work necessary to create the
CityStateZip value by hand. But this is a perfect place for a simple function:

• What goes in: the three pieces of information, which are City, State,
and Zip.

• What comes out: the formatted CityStateZip value.

To create a VBA function, open the Visual Basic Editor, create a module, enter
VBA code into the module, and then run the code.

Follow these steps to create your first function:

1. Start Microsoft Excel.

We’ll use Microsoft Excel for this example, but feel free to use a
different application, because this code will run from any VBA host.

2. Create a new workbook in Microsoft Excel, if one hasn’t been created
for you already.
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3. From the Tools menu, select MacroVisual Basic Editor.

4. In the Project Explorer, select the project that corresponds to the new
workbook.

5. In the VBE, click Insert Module. This creates a new code module as
shown inFigure 7.

Figure 7. A new module in the Visual Basic Editor.

6. From the Insert menu choose Procedure to bring up the Add
Procedure dialog box. Enter the name of the new procedure
(BuildCSZ, in this case), make sure that the Function option button has
been selected, and click OK.
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Figure 8. The Add Procedure dialog box is one of many ways you can create a
new procedure.

VBA will create the stub of the procedure for you, waiting for you to enter
the code that will do the work. You will be able to provide your own
values because VBA cannot guess the types of values to use.

Public Function BuildCSZ()

End Function

NOTE The “Public” keyword indicates that any other procedure,
anywhere, can call this function.

Enter the three parameters for your function, indicating that you’ll be
passing values for City, State, and Zip. These parameters act like
placeholders for the values you’ll give the function when you run it.

Public Function BuildCSZ(City, State, Zip)

End Function

Supply the code that does the work inside the function. Don’t worry; we’ll
go over the new ideas in just a minute.
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Public Function BuildCSZ(City, State, Zip)

' Convert the separate City, State, and Zip

' fields into a single formatted string.

BuildCSZ = UCase(City & " " & State & " " & Zip)

End Function

In the Immediate Window, type:

? BuildCSZ("Houston", "TX", 77024)

 VBA responds with this text :

HOUSTON TX 77024

Now you have a real VBA function.  So what was all that new stuff?

• What’s the single quote character (') for? The single quote character
denotes a comment. A comment has no effect when your code runs;
it’s simply for making developer notes to yourself. You can, and
should, use comments in your code to make notes for yourself and for
other programmers who might use your code in the future.

• What’s UCase? The UCase function, built into VBA, converts text to
UPPER CASE.

• Why “&”? The “&” operator links text together, leaving no spaces
between the two pieces of text. Leaving this out would have generated
an error because VBA expects an operator to tell it what to do with the
two text strings.

• What’s the " " for? As mentioned in the previous point, the “&”
operator links text with no spaces. If you want to add a space between
two pieces of text, you must insert it yourself, using a string that
represents a single space character (" ").

If you had left this out, your function would have returned:

HOUSTONTX77024
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Not exactly what the Post Office wants! Watch out for this in your
code when  working with strings; it’s easy to concatenate a string
incorrectly.

• How do you return a value from the function? By assigning a value
to the function name itself, VBA knows to send the assigned value
back as the return value. If you don’t take this step, the function won’t
return a value. In our case, you use this expression to cause BuildCSZ
to return the correct value:

BuildCSZ = UCase(City & " " & State & " " & Zip)
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Running Your Function from Word

We’ve said that since VBA is a cross-product language, your VBA code will
run in any VBA host application. We’ll take the function you just created and
now run it in Word.

NOTE Keep in mind that only generic code will run in any host
application. Code that takes advantage of a particular application’s
functionality may not run in another application. For example, if
you write code to format a Microsoft Excel spreadsheet, you’ll
have to modify it before you can use it to format a Word
document.

One easy way to share code is to simply drag and drop it into another
application. To drag and drop the BuildCSZ function into Word, follow these
steps:

1. Start Word and create a new document.

Again, we’ll show our example in Word, but feel free to try this with
any host application.

2. Choose the Tools, Macro, and the Visual Basic Editor menu items to
open the VBE from Word.

3. When you open the VBE from Word, it opens in a separate window,
just like it did with Microsoft Excel. Now you may have both Word
and Microsoft Excel open, and both of their Visual Basic Editors open
as well.

4. Arrange both Visual Basic Editors so you can see them on the screen
at the same time.

5. Select the CSZ module from the Microsoft Excel VBE and drag it to
the Word VBE. Dropping it onto the entry for “Project” in the Word
VBE Project Explorer creates a new module in the Word project.

6. Test the function in Word in the Immediate window, the same way
that you did in Microsoft Excel:

? BuildCSZ("Houston", "TX", 77024)

The function works exactly the same as it did in Microsoft Excel.
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Taking Advantage of IntelliSense

Microsoft has included some truly timesaving features in the latest version of
VBA. These features, called IntelliSense, can reduce the amount of typing you
have to do as you’re writing code.

List Properties/Methods (CTRL+J)

As you’re typing code into the module editor and type in a period or
exclamation point, VBA will provide a list of applicable properties and
methods. Figure 9 shows this feature in action.

Figure 9. Use List Properties/Methods to view methods and properties of any
object.

Once you have selected an item in the list, you can commit it by pressing the
Tab key or the space bar, or by double-clicking the item. Pressing the Enter
key also commits the item, but then moves the cursor to a new line, which can
be annoying if you weren't finished typing the statement. These methods also
work for the List Constants feature, described in the following section.

If you’ve disabled the Auto List Members option on the Editor tab of the
Tools|Options dialog box, you can force VBA to show the list by pressing
CTRL+J.

List Constants (CTRL+SHIFT+J)

When entering functions that accept enumerated values as parameters, VBA
provides a list of available constants. Figure 10 shows what you might see
when calling the MsgBox procedure in your code. If the Auto List Members
option is not selected, you can display this list by pressing CTRL+SHIFT+J.
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Figure 10. VBA can list available constants for you (CTRL+SHIFT+J).

Parameter Info (CTRL+SHIFT+I)

The Parameter Info feature is very useful when working with unfamiliar built-
in or user-defined functions. As you enter parameters for procedures, VBA
provides a list of the parameters and their types, as well as the default value, if
any. Figure 11 shows the Parameter Info tip for the MsgBox statement.

If you’ve cleared the Auto Quick Info check box in the Editor tab of the
Tools|Options dialog box, you can press CTRL+SHIFT+I to display the tip.

Figure 11. Parameter Info makes it easier to enter complex procedure calls.
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Word Completion

Rounding out the arsenal of IntelliSense features, VBA can complete words
for you as you type them. As soon as VBA recognizes a unique match between
what you’ve typed and names it’s parsed out of your code, you can press
CTRL+SPACEBAR to finish the keyword for you. If you haven’t typed enough
for a unique match, VBA will present a list of options when you press
CTRL+SPACEBAR.

This excellent time-saver works both with built-in and user-defined keywords,
variables, and constants.

NOTE IntelliSense adds one more feature that we’ll demonstrate later:
Auto Data Tips. This feature allows you to see the value of any
simple variable or expression when you’re debugging your code.
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Summary

• The Project Explorer helps to manage your projects.

• The Properties window contains properties for each object that can be
set on an as needed basis.

• The Immediate window allows you to evaluate expressions
interactively, while your code is running.

• A VBA project contains all of the forms and modules associated with
your application. For Microsoft Office applications, saving the file
also saves the associated project.

• To change the name for a project, set the (Name) property in the
Properties window.

• A Function procedure performs an operation and returns a value.

• A Sub procedure performs an operation but doesn’t return a value.

• Generic procedures created in one VBA host application can be run as-
is in another application.


